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[bookmark: _Toc93939286]1.0 Employee Planning Overview
[bookmark: _Toc299371820]This document discusses Employee Planning, the UPlan module that enables detailed salary and benefit expense planning.  Planners may plan for individual employees, groups of employees, and anticipated hires or reductions.  Note that throughout this manual, “planners” and “you” are used interchangeably.
Employee data feeds from UC Payroll, Academic Personnel, Timekeeping, and Human Resources (UCPath).
Control Points and Level 2 departments can adjust global assumptions for salary levels and benefit costs.
Employee Planning is available for the Current Year forecast, Year 1 plan, and Year 2 plan
For each current employee, planners may:
· Adjust salary rate levels and benefit rates by month
· Distribute pay across department, fund and project sources by month
· Identify sources of funds to cover salary over the NIH cap (currently unavailable)
Planners can also create new hires or planned reductions, either as individuals or groups.
[bookmark: _Toc93939287]1.1 Employee Planning Features 
If you are planning at the individual employee level, you have two primary tasks:
First, you can plan salary and benefit levels for individuals whose Salary Level Planning Department is one of your planning DeptIDs.  What this means is that the DeptID on an individual’s primary jobcode is either the same as, or was mapped to, one of your planning DeptIDs, and you therefore have the ability to adjust the salary and benefit levels for this employee.  In this case, we say that you “own” the employee.
Second, for any employee, you can plan a pay distribution if one of your planning DeptIDs provides funding to support that employee’s salary and benefits, either now or in the future.  In this case, we refer to the planning DeptID as a Pay Distribution Department and we say that you “fund” the employee.
The UPlan Employee Planning module provides capability to address all these situations.
Reminder: Because HR departments may not be planning departments themselves, a process was established to map HR departments to planning DeptIDs based on Control Point and department input.  These planning DeptIDs have the ability to plan the salary levels for the employees will be referred to as the Salary Level Planning DeptID. Throughout this lesson, we will talk about employees owned or not owned by your salary-level planning DeptID.
Employee Planning was designed to give Control Points and their departments flexibility in planning their salary and benefit expenses.  You can put as much or as little detail into employee planning as your Control Point directs.
For detailed employee planning, you can identify each individual’s specific salary components, benefits, and distributions, including plans for salary increases by employee.  
Some Control Points may direct planners to only use “To-Be-Hired” forms to plan for salary increases for groups of employees.
On the other end of the spectrum, it is possible to enter aggregated amounts for salary and benefit expenses by DeptID, Fund, and Project (DFP) within the General Planning module.
For most Control Points, planners will at least do some detailed employee planning, along with new-hire planning.  Your Control Point will have more information for you on their requirements.
The Employee Planning module provides several features to facilitate comprehensive planning for salary and benefit expenses.
[bookmark: _Toc93939288]Adjusting Salary and Benefits for Individual Employees
Data entry forms are initially pre-populated with employee characteristics, salary levels, benefits rates, and DFP distributions from the prior fiscal year final plan at the start of every fiscal year and updated by planners over the course of the year; the current fiscal year is known as the forecast.  As the forecast months close, payroll actuals from UCPath are loaded and overrides data in the now closed month.  Additionally, the salary rate levels are trued up with UCPath data and flow to the forecast open months.  Planners have the option to then seed the Year 1 plan data as well as reseed portions of the forecast.  If the planner owns the employee, they can adjust the salary levels and benefit rates across two pay components, which are aggregated UCPath Earnings (ERN) Codes groupings: base and negotiated salary, and additional salary.  If the planner funds the employee, they can distribute salary and benefit costs by the pay component across DFP combinations.
[bookmark: _Toc93939289]Adjusting Salary and Benefits for “To-be-hired” Employees
Planners can create (or delete) provisions for planned new hires and negative provisions for salary savings due to separations.  These provisions, known as To-Be-Hired (TBH) employees, may be individuals or groups and characteristics, such as jobcode, may or may not be specified.
Similar to current employees, for the forecast and Year 1 plan, planners have the ability to distribute salary and benefit costs for TBH employees across multiple DFP combinations.
[bookmark: _Toc93939290]Funding for Salary and Benefits NIH Over-the-Cap (currently unavailable)
For both existing and TBH employees, UPlan will identify salary amounts that are unfunded due to NIH salary caps and enable planners to distribute sources of support to cover the unfunded cost by non-NIH DFP(s).  Note that this is an optional feature.  
[bookmark: _Toc93939291]Employee Planning Business Process 
As with General Planning and Commitment Tracking, there is no single, correct way to approach your forecasting and planning for Employee Planning.  Each Control Point will have different guidelines for their planners.  And, even within those guidelines, you have many options regarding the order of planning tasks.  Here, we will assume that you are going to plan in detail for your existing and future employees.
The following graphic helps give you a visual perspective on Employee Planning.  Each large block represents activities to be addressed. Notice there are no arrows connecting these blocks.  This indicates that you are not required to proceed in the exact order.
[image: C:\Users\Carol\AppData\Local\Temp\image001.jpg]
Initially, you may want to use Employee Planning reports within UPlan (such as the Compensation Detail by DFP report) to check the current state of forecast and plans for existing employees.  These will help you determine which individuals’ compensation forecast or plans you need to update.  You can start with current employees in your own department, current employees in other departments for whom you provide funding, or TBH employees.  You can also review and adjust benefit rate information for the two pay components.  Finally, after you complete updates to forecasts or plans, you can review diagnostic reports to check balances and look for errors.
[bookmark: _Toc93939292]What is Not Included in Employee Planning
All planning will be based on total salary for each month. Employee Planning does not include functionality for planning hourly pay.  In addition, Employee Planning also does not address bi-weekly pay dates or hire anniversary dates (identifying merit or end dates).
Planners will need to track salary cap funding for non-NIH projects manually.  These salary restrictions are unique to each award and usually stated in the contract.  These are not currently tracked by any codes captured in Research Administration System (RAS).
Employees whose HR department is the UCSF Medical Center are not included nor are distributions for campus employees who are with fully or partially funded by the Medical Center. 
[bookmark: _Toc93939293]Pay Components 
An individual employee’s compensation may be comprised of many payroll components from the UCPath called Earnings (ERN) codes that describe different types of pay.  UPlan maps the majority of these Earnings codes into two pay component groups for planning.  This table provides an overview of the pay components.  (Note that throughout this manual, “pay component” and “salary component” are used interchangeably.) 

	Salary Component
	Faculty Salary and Benefits
	Non-Faculty Academic/Staff Salary and Benefits

	Base and Negotiated
	· Includes X and X' components of faculty salary (Health Sciences Compensation Plan) as well as credits that impact base pay.
· Includes Y component of faculty salary (Health Sciences Compensation Plan)
	· Includes regular salary and those salaries that are treated like regular pay as well as credits that impact base pay.

	Additional/
Other
	· Includes all salary not included in the X and Y components of faculty salary.
	· Includes all non-base salary, such as shift differentials and overtime.


[bookmark: _Toc93939294][bookmark: _Toc367773955]Employee Type 
There are three Employee Types - Faculty Academic, Non-faculty Academic, and Staff Employee – that are based on jobcode.  Salary and benefit expenses from Employee Planning will flow into General Planning into accounts depending on the employee type and pay component. For example, projected expenses for “Faculty Academic” and “Base and Negotiated” flow into Accounts “5000C: Faculty salaries_C” and “5030C: Faculty benefits_C”.
[bookmark: _Toc93939295]Employee Planning Data Entry Forms
Employee Planning includes three sets of planning forms along with reports and other functionality on the Task List.
	Folder
	Forms

	Individual Employee Forms
	· Search Individual Employees
· Employee Landing Page
· NIH OTC Forms (currently unavailable)

	Multi-Employee Forms
	· Multi-Employee Salary and Benefit Levels
· Multi-Employee Distribution Percentages

	TBH Employee Forms
	· Search Individual Employees
· TBH Employee Landing Page

	Empl Global Assumptions
	· Salary Global Assumptions

	Empl Seeding Options
	· Year 1 - Salary Level
· Year 1 - Benefits Level
· [image: https://uplan.ucsf.edu/HyperionPlanning/adf/images/t.gif]Year 1 - Distribution Pct %
· Year 2 - Salary, Benefits, and Dist Pct %

	Empl Reports
	· Compensation Detail by DFP
· Multi-Empl Distr Pct and $

	Push Empl Data to General
	


[bookmark: _Toc93939296]2.0 Individual Employee Forms
[bookmark: _Toc93939297]2.1 Search Individual Employees
The Search Individual Employee form (also known as the Employee Composite form) allows data entry for a single employee.  Planners can adjust salary levels, benefits rates, and pay distributions on this form. 
 [image: ]The Page drop-down Filter contains the Employee dimension.  The form has five tabs for data entry and review, reducing the effort to load separate forms for different aspects of planning.
	Tab
	Label
	Functionality

	1. Employee Salary and Benefits Level
	Empl Sal&Ben Level
	Updates to salary and benefit rate levels

	2. Pay Distributions
	Empl Distr Pct
	Updates to pay distribution percentages

	3. Distributed Salary
	Empl Distr Sal $
	Review calculated salary dollar distributions

	4. Distributed Benefits
	Empl Distr Ben $
	Review calculated benefit dollar distributions

	5. Employee Summary
	Empl Summary
	Updates to employee characteristics


Columns for Tabs 1-4 include the Forecast scenario for the current year and Plan scenarios for Year 1 and Year 2 where all years are expandable to months.  The YearTotal for dollar value accounts sums July-June values whereas the YearTotal for percentage-value accounts reflects the last month that contains a value.  Tabs 3-4 show the calculated distributed dollars of the salary and benefit level against the pay distribution percentages and are read-only.  For Tab 5, the summary data columns show the plan and forecast scenarios for the current year, and plan scenarios for Years 1 2; these columns are not expandable to months.
All tabs include jobcode and DeptID as rows.  Other rows for pay component, fund and project may be included depending on the tab. 
[bookmark: _Toc93939298]Tab 1 Employee Salary and Benefits Level
Tab 1 (Empl Sal&Ben Level) allows planners to update the salary and benefit rate levels by pay component and re-calculates new values upon save. 
 [image: ]
Salary Level section  
The following table summarizes the salary level rows on this tab:
	Rows (Accounts)
	Description

	Initial Base&Neg Salary
	Base and Negotiated Salary amount at the beginning of the period, before any salary adjustments are made

	Global Assumptions %
	Salary increase percentage based on the global assumption for the Union Code to which the Employee belongs

	Override Global %
	Salary driver to override the global assumption for base and negotiated salary increase for this employee/jobcode combination

	Global Assumptions Impact $
	Calculated dollar amount of the Global Assumptions % or the Override Global %

	Salary Level Override
	Base and negotiated salary level entered by planner to override initial base and negotiated salary amount and percentage increases.  When a forecast month closes, this field is trued up with the salary level from UCPath and carries forward to the next month. 

	New Base&Neg Salary
	Ending base and negotiated salary calculated based on above salary driver accounts

	Addtl Salary
	“Catch-all” salary component that includes other Earnings codes not applied to Base or Negotiated Salary.  Examples include stipends and overtime. 

	Ending Total Salary
	The sum of New Base&Neg Salary, Addtl Salary, and Non-UCSF Pay.



For Base and Negotiated salary, both the initial monthly salary and the global assumption percentage are displayed.  Planners can override the global assumption percentage with another percentage adjustment in the Override Global % field.  Planners can also simply enter a new monthly salary amount in the Salary Level Override, which takes precedence over the global assumption and the override percentages.  As each forecast month closes, the Base and Negotiated salary is trued up with current data from UCPath.  The resulting ending salary is then shown in the New Base&Neg Salary, which carries forward as the Initial Base&Neg Salary in future months as Base and Negotiated salary are considered recurring pay.  

As shown in the example below, the new base and negotiated salary is calculated based on the four rows above it.
	
	Row
	Jul
	Aug
	Sep
	Oct
	Nov
	Dec

	(A)
	Initial Base&Neg Salary
	$100,000
	$100,000
	$104,000
	$104,000
	$110,000
	$110,000

	(B)
	Global Assumptions %
	
	3%
	
	
	
	

	(C)
	Override Global %
	
	4%
	
	5%
	
	

	(D)
	Global Assumptions Impact $
	
	$4,000
	
	
	
	

	(E)
	Salary Level Override
	
	
	
	$110,000
	
	

	(F)
	New Base&Neg Salary
	$100,000
	$104,000
	$104,000
	$110,000
	$110,000
	$110,000

	
	
	(1)
	(2)
	(3)
	(4)
	
	


(1) Because rows B, C, D and E are blank, the new salary equals the initial salary
(2) Row C takes precedence over Row B, and therefore the salary increases by 4%
(3) Note that the New Base&Neg Salary (F) for the prior month becomes the Initial Base&Neg Salary (A) for the next month
(4) Row E takes precedence over Row C, and therefore the salary changes to $110,000

For Addtl Salary, planners simply enter the values in the relevant months.  The values in this pay component are trued up with UCPath data as each forecast month closes but do not carry forward to any future months as these are considered one-time or short-term pay.
Benefit Rate Level section
The following table describes the benefit rate level rows on the Employee Benefits form:
	Rows (Accounts)
	Description

	System-estimated Rate Accounts
	Read-only

	Benefits (%)
	· Seeded/calculated estimate of benefits rate for base and negotiated salary
· Rate in Forecast = Planning CBR %, however, rate in Actuals = CBR + VLA + UCRP Supplemental Interest.  This % rolls forward into open forecast and overrides the Planning CBR %.
· The Planning CBR % is brought into the Forecast nightly, and will soon be brought into the Plan
· The planning rate is slightly lower than the real CBR charged to the department to account for the VLA credit to the department when the employee takes vacation
· For HCOMP-eligible employees, the Benefits % includes the .8% Faculty childbearing/childrearing assessment

	Rate Override Accounts
	Writable

	Benefits Adj (%)
	Planner-entered overrides the Benefits % account if there is a value in the cell, and calculates on the “New Base&Neg Salary” account

	Dollar Amounts
	Read-only

	Benefits ($)
	Dollar amount of benefits for base and negotiated salary




The form displays the calculated benefits amounts based on either the original or adjusted benefits rates against the salary rate level for each pay component.  Actuals carry forward to future months; planners should enter overrides for all months as appropriate. 
[bookmark: _Toc93939299]Tab 2 Pay Distributions
Tab 2 (Empl Distr Pct) allows adjustments to pay distributions by salary component.  Rows include funding DeptID, Fund, and Project.  All actual and planned DFP combinations are displayed.  New DFP distribution line added in UCPath will load to UPlan nightly, however, only the new DFP members will appear, not the percentage values from UCPath.  This allows planners ease of entering percentage data without the need to add new DFP distribution row(s).  Totals by jobcode and pay component are displayed at the bottom of the form.  
  [image: ]

Values do not carry-forward from one month to the next, so planners must copy percentage adjustments to future months.  
Write access is provided based on planner security settings.  Planners may only add or adjust distributions for DeptIDs they own.
Since the accounts on the Employee Distributions form are all percent values, the YearTotal column will display the last non-missing value.  This feature is known as the “time-balance-last”.  For example, if June contains a percentage, the June value will appear in the YearTotal.  If June does not contain a percentage, but May does, the YearTotal column will display the May value.  
Additionally, the time-balance-last feature for percentage directs data entered in the YearTotal column to spread to all months if there is no data in any of the months.  If data does exist in any of the months, then the percentage value entered will populate June only.  
Best Practice: Avoid entering data in the YearTotal column, unless you just added a New DFP combination
[bookmark: _Toc93939300]Adding and Deleting Distributions
In some cases, you may need to add a funding distribution for an employee who is either owned by your department or owned by another department which your department funds.  As noted above, planners can add a distribution for their DeptID(s), but cannot add or make adjustments to distributions for DeptIDs they do not control.
Where to Right-Click
You can right-click anywhere in the Empl Distr Pct tab and select Add_ Dist to add a new distribution.  *Tip - clicking on an existing distribution will pre-populate the form with the same Jobcode, Salary Component, and DFP combination you selected, which can be helpful if there is only one of these attributes that need to be changed for the new distribution.  
To add a distribution:
1. Right-click anywhere in the Empl Distr Pct tab workspace and select Add_Dist. 
 [image: ]
The Add_Distrib prompt will appear.  To change a value, simply type in the value in the appropriate field or search by clicking the Member Selection pull-down icon to the far right. The Planning Scenario can be either “Forecast” or “Plan”. 

[image: ]If employee has more than one Jobcode shown on the Empl Sal&Ben Level, ensure that the correct jobcode is selected.  Otherwise, click on the member selection pull-down icon to search for the correct jobcode.  Note that jobcodes that do not already exist on the Empl Sal&Ben Level tab cannot be added. To search for the jobcode, either enter the jobcode in the search box and click the magnifying glass icon or expand the All Title_Code section to manually scroll through the jobcodes.  To select the jobcode once it is found on the left section of the dialog box, click on it, then click the Add arrow to add to the right section and then click the OK button. Note that you may need to scroll down and to the right to see the OK button.
*Tip – the jobcodes usually show in the row on the distribution tab so there is usually little need to search for the jobcode; simply right-click on the row with the appropriate jobcode to pre-populate the new distribution row with the same jobcode.  
[image: ]
If the pay component account needs to be adjusted, click in the member selection pull-down icon.  There are only 2 pay components to choose from.  Click on the appropriate pay component account, then click the Add arrow, and then click the OK button.  
[image: ]
Repeat these steps on the Add_Distrib prompt to adjust the Funding DeptID, Fund and Project as needed.
When you have finished filling in all fields, click the Launch button.  
 [image: ]
If the new distribution was added successfully, the below message will appear.  Click OK to remove the message.  
  [image: ]
 [image: ]
If the new distribution was not added successfully, the below error message will appear.  This is usually due to the jobcode not already existing on the Empl Sal&Ben Level tab. You will need to add the new distribution line again using the appropriate jobcode on the Empl Sal&Ben Level tab.
[image: ]
Once the new distribution row is added, enter distribution percentages for the appropriate open months in the Forecast and/Plan and save to calculate the distribution dollars for salary and benefits, which will appear on tabs 3 and 4.  
To delete a distribution: 
1. Make sure that there are no percentage values in the DFP distribution row, otherwise, the system will not allow you to delete the row.  
2. Right-click on the Project field (in the right most column) for the row you want to delete and select Delete_Dist. 
 [image: ] 
3. The selected row will be deleted and a message displays, indicating the distribution was successfully deleted.
[image: ]
[bookmark: _Toc93939301]Distribution Percentages
You should know the percentages you are distributing from each of your own DFP combinations, and how this fits into the overall distribution for the employee.  You may need to communicate with other departments funding the individual employee.  In addition, you can view current percentages using payroll reports in MyReports or the various distribution forms/reports in UPlan.
[bookmark: _Toc93939302]More than 100%?
You may notice that the total Base&Neg % for an employee may exceed 100%.  This will occur if the selected employee has one or more distributions in UCPath that are at 0% but are actually paid at 100% of the pay rate (such as NIH over-the-cap pay).  This could also occur for actuals if an employee received retroactive pay that exceeded the normal 100% of the salary rate level for the month.  
UPlan requires a percentage in order to calculate the dollar amount so you may need to inflate the distribution percentage to account for these types of pay.  Other examples include post-doc employees who have stipends that are treated as base pay.
[bookmark: _Toc93939303]Tab 3 Distributed Salary and Tab 4 Distributed Benefits
Tabs 3 and 4 display the calculated dollar amounts of planned pay distributions by DFP.  
Tab 3 (Empl Distr Sal $) shows the distributed salary amounts for each salary component and DFP combination.   
 [image: ]

Tab 4 (Empl Distr Ben $) shows the distributed benefits amounts for each salary component and DFP combination. 
 [image: ]
These forms are not writable.  Once salary rate levels, benefit rates, and distribution percentages on other tabs are entered for the relevant pay component, the distribution dollar values on these two tabs are updated for the open months upon save.  Totals by jobcode and pay component are displayed at the bottom of the form.  
Once a month closes, salary and benefit actual expense will populate from the payroll sub-ledger (Distribution of Payroll Expense or DPE) to these two tabs.
[bookmark: _Toc93939304]Tab 5 Employee Summary
Tab 5 (Empl Summary) contains summary information about the employee.  In addition to Jobcode and (home) DeptID, rows include various employee characteristics.  If desired, planners can update values for Rank, Step, and FTE.  Other values are calculated based on the New Base&Neg salary level from Tab 1 Empl Salary. 
 [image: ]

	Rows (Accounts)
	Description

	Rank
	Smart List indicating a jobcode’s rank (only applicable to some faculty and non-faculty academics titles).  Choices are:  NA, FULL, ASSOC, ASST, INSTR.  This is informational only and is not used in calculations.

	Empl Grade_Step
	Smart List, with a drop down box giving you choices for grades or steps.  For employees with no grade or step, select NoGradeStep.  This is informational only and is not used in calculations.

	FTE
	Full Time Equivalent; enter 1.0 for Full time; 0.5 for half time, etc.  This is informational only and is not used in calculations.

	Beginning Total Salary
	New Base&Neg Salary Level at the beginning of the period (July)

	Ending Total Salary
	New Base&Neg Salary Level at the end of the period (June)

	Ending Salary Variance $
	Year-over-year dollar change in Ending Total Salary

	Ending Salary Variance %
	Year-over-year percentage change in Ending Total Salary


[bookmark: _Toc93939305]2.2 Employee Landing Page 
The Employee Landing Page lists all of the employees in a selected MyOrg.   Rows are the DeptID (HR), Employee, and Jobcode.  Columns include the current year forecast and Year 1 plan with additional account detail.  
The Landing Page gives you a view of employees and their compensation information to help determine whether adjustments need to be made.  You cannot edit data on this screen, as is indicated by the gray cells.  
From this Landing Page, you can select an employee or TBH, right-click, and select the Go to Empl Forms or Go to the TBH Forms to navigate to the selected employee or TBH’s individual forms to make edits. 
For both the Current Year Forecast and the Year 1 Plan, the following data elements are displayed in columns.  
	Columns (Accounts)
	Description

	New Base&Neg Salary
	Year-total base and negotiated salary level planned

	FTE
	Full Time Equivalent value for the Employee/Jobcode intersection. The FTE values come from the Empl Summary tab of the Employee Composite form.

	Base&Neg Dist (%)
	Total percentage of Base and negotiated salary planned for June 

	[FTE-Base&Neg Dist%]
	Difference between the FTE value and the total percentage of Base and negotiated salary planned for June; a non-zero value indicates that either the FTE value or the planned distributions are incorrect and should be adjusted.


*Note: If you get a message that you must set MyOrg before you can access the form, you must set the MyOrg in Preferences>User Variable Options.  After entering your selected MyOrg DeptID, click save. 
[image: ] 
[bookmark: _Toc93939306]Who Appears on Your Landing Page
Employees who are owned by your planning DeptIDs will appear on the landing page, based on the MyOrg you selected, for each planning DeptID.  Employees for whom you provide salary and benefit funding, but do not own, will not appear on the Landing Page unless you choose the MyOrg planning DeptID that owns them.  
 
[image: ]
[bookmark: _Toc93939307]Right-Click Menu Options
From the Employee Landing Page, planners can navigate to the individual employee or TBH form and make adjustments for that employee.  The individual employee or TBH forms are named “Search Individual Empl” and “Search Individual TBH”, respectively.
To navigate to the individual employee or TBH form:
 Right-click on the Jobcode for the Employee or TBH you want to adjust and select Go to Empl Forms or Go to TBH Forms. 
 [image: Graphical user interface, text, application

Description automatically generated]
The Search Individual Empl or Search Individual TBH form will appear.  The Page Filter will reflect the selected Employee or TBH.  
[image: ] 
Select the tab where you want to adjust data and make your changes.
To return to the landing page, you can click on the Employee Landing link on the breadcrumb at the top of the form.  Another option is to click on the Empl Landing Page under My Task List.
[image: ] 
 
[image: ]
[bookmark: _Toc93939308]2.3 NIH Over-the-cap (OTC) Form (currently unavailable)
[bookmark: _Toc367773977]Employees who are paid from NIH sponsored projects may have a salary amount that is in excess of the NIH salary cap, known as the NIH OTC amount.  Note that the policy for NIH salary caps are determined by the National Institutes of Health agency (not UCSF or UPlan) and apply to all of their project awards that fund salary and benefits.  More information about the salary caps is available on their website http://grants.nih.gov/grants/policy/salcap_summary.htm.  
Planners can opt to use the NIH OTC form to add non-NIH project funding distributions to cover the NIH OTC amount.  This optional form is only available for existing employees and not available for TBH employees.  For each employee funded from an NIH project, UPlan determines whether there is unfunded salary and benefits due to the NIH salary cap(s) and these are shown on the NIH OTC form.  Planners determine and add the non-NIH funding DFP distribution(s) to cover the NIH OTC amount as needed on the form.  
The NIH OTC amount is auto-calculated for each applicable salary and benefits distribution for the planning-only and adjustment projects for NIH sponsored projects (e.g. 2011365: FP Sponsored NIHCap1, 2011366: FP Sponsored NIHCap2, ADJ Sponsored NIHCap1, ADJ Sponsored NIHCap2, etc).  The salary and benefit distribution dollars are aggregated to these planning-only sponsored projects and calculated against the salary rate level and benefit rate level to determine the NIH OTC amount.  Note that the NIH OTC amounts calculate against the total distributions for the FP Sponsored NIHCap and the corresponding ADJ Sponsored NIHCap projects (e.g. total for 2011365: FP Sponsored NIHCap1 and ADJ Sponsored NIHCap1).
The calculations follow the methodology directed by NIH and consist of five general steps:
1. Calculate the monthly total salary amount from the annual salary
2. Calculate the allocated monthly salary amount supported by an NIH grant
3. Calculate the capped monthly NIH salary amount
4. Calculate the unfunded salary amount
5. Calculate the associated unfunded benefits amount
[bookmark: _Toc93939309]NIH OTC Form (currently unavailable)
The NIH over-the-cap (OTC) salary and benefit amount for an employee funded by an NIH award(s) is displayed on the top section of the NIH OTC form.  The bottom section allows the planner to add non-NIH project distributions to fund the OTC amount.
You may add multiple distribution rows by right-clicking on the project and selecting Add NIH Distribution.  Likewise, distributions can be deleted by selecting Remove NIH Distribution
Distributions will be entered by month as percentages for the DFP(s) and should total 100% to fully cover the NIH OTC $ amount. 
Distributions for employees with NIH OTC $ amounts should be carefully reviewed since duplications may exist where the NIH over-cap-amount is already accounted for.  Below are some examples where you may not want to use the NIH OTC form.
· Distributions to cover the NIH OTC $ are planned for in Faculty Portfolio under the retention, recruitment, or other faculty/PI project use and the distribution percentages may copy over if you had copied over the FP Feed employee data.
· You or another planner may have already added non-NIH DFP distributions to cover the NIH OTC amount in the Empl Distr Pct tab of the individual employee form or the Multi-Empl Distr Pct form. 
· UPlan cannot identify whether these duplicate distributions are related to covering the NIH OTC amount.  Some tips to identify whether these duplications exists include:
· The NIH OTC amount is a pay type where in UCPath, the pay distribution % are at 0% but are actually paid at 100% of the salary rate so if these are included, the total distribution percentages for the Base and Negotiated pay component shown on the Empl Distr Pct tab of the individual employee form will likely be over 100%.  
· Communicate with your Research Support Analyst (RSA) who plans within Faculty Portfolio or your payroll processor who enters data within UCPath.

[bookmark: _Toc93939310]3.0 Multi-Employee Forms
Two multi-employee forms are provided; one for salary and benefit rate level adjustments and one for pay distribution adjustments.  These forms are meant to enable planners to add planning information in a time-efficient manner and may not allow planning for the Additional/Other pay component.  Both forms also allow you to navigate to the individual employee or TBH forms via the right-click menu to make additional edits to specific employees.
[bookmark: _Toc93939311]3.1 Multi-employee Salary and Benefit Level Form
The Multi-employee Salary and Benefit Level form allows planners to edit base and negotiated compensation for employees owned by the selected MyOrg DeptID.  For efficiency in planning, this form does not include the Additional/Other pay component; if you need to plan for this pay component in your Forecast or Year 1 Plan for an employee, please do so in the individual employee form.  Planners can view existing data related to the base and negotiated salary and benefit levels and enter an updated salary value and a benefit adjustment percentage for multiple employees on the same form.  There is no right-click menu ability to add or delete accounts. 
  [image: ]
· Page Filter:  MyOrg
· Rows: (home) DeptID, Employee, Jobcode, and Account (five base and negotiated salary and benefit accounts)
· Columns: Year, Scenario, Version, and Period (months)
For each Employee and Jobcode, the following five rows will appear on the form:
	Account
	Use

	Initial Base&Neg Salary
	Read-only

	Salary Level Override
	Enter the corrected salary value to override the Initial Base&Neg Salary

	Benefits (%)
	Read-only

	Benefits Adj (%)
	Enter the benefits adjustment percentage for each month to override the Benefits (%)

	Benefits ($)
	Read-only



[bookmark: _Toc93939312]3.2 Multi-employee Pay Distribution Form
The Multi-employee Pay Distribution form allows planners to add or delete distributions for employees funded by the selected MyOrg DeptID.  The layout and functionality of the form is similar to tab 3 of the individual employee form where planners can view existing distributions, make adjustments to those distributions and add or delete distributions.  This form includes distributions for all pay components.
 [image: ]
· Page Filter:  MyOrg
· Rows: Funding DeptID, Employee, Jobcode, Pay Component, DeptID, Fund, and Project 
· Columns: Year, Scenario, Version, and Period (months)
You can add and delete distributions by right-clicking on the Project and selecting Add Dist or Delete Dist.  
[image: ] 
*Tip - You can make changes for multiple employees and submit (save) the data to UPlan when you are finished.  However, if you are going to add or delete distributions, you should submit/save any changes you have made up to that point. 
[bookmark: _Toc93939313]4.0 To-Be-Hired Employee Forms
This section covers how to plan for To-be-hired (TBH) employees, including the following topics:
Use the TBH forms for group provisions
Use of the TBH Landing Page Form
Adjust TBH employees’ salaries
Add and adjust distributions for to be hired employees
Understand how data is seeded for TBH provisions
[bookmark: _Toc93939314]What is a TBH Provision?
A TBH provision is placeholder for an individual or group of employees to be hired.  Throughout this lesson, these are referred to as either “TBH provisions”, “TBH employees”, or simply “TBH”.  TBH provisions could also be used for salary savings and reductions or additional salary funding you expect to distribute to specific DFP’s but don’t know exactly which specific employee would be impacted.  In fact, you can use a TBH whenever you want to capture a change in any salary/benefit expenditure in the forecast or Year 1 plan.
As with existing employees, you can plan salary and benefits for the two pay components for TBH provisions you own (e.g. the TBH’s belong to your home department).  You along with planners in other departments who fund the TBH provision can plan the funding DFP distributions.  
The TBH Employees Landing Page is where you can create the new TBH provision to begin planning.
You can provision TBH employees one by one, based on specific requisitions you have or expect to have over the coming forecast or Year 1 plan horizon.
In addition, you can leverage the TBH Employees forms to plan on a group level for some or all of your salary and benefit expenses.
The Search Individual TBH Form is where you modify detail data about your TBHs.
TBH’s can also be modified on the two Multi-Employee forms.
[bookmark: _Toc93939315]Using TBH for Group Provisioning
Once the new TBH is created, you can leverage the Search Individual TBH form to plan on a group level for some or all of your salary and benefit expenses.  Here are some examples:
You can include a line item for five new professors.
You can plan for 20 new full time staff employees.
You can add a “dummy” TBH that covers the expected salary and/or benefit increases for the entire DeptID.
You can include negative entries to show savings in employee expenses.
You can add to be hired employees whom you will only fund but do not own.

[bookmark: _Toc93939316]4.1 TBH Landing Page Form
The TBH Landing Page is where you add new TBH provisions and is read-only.  Once you begin to add TBH entries, the Landing Page serves as a roster of TBH’s for your DeptID and you can navigate to the Search Individual TBH forms to edit the salary rate level, benefit rate level, and the funding DFP distributions by pay component. 
  [image: ]
· Page Filter:  MyOrg
· Rows: (home) DeptID, Employee (To Be Hired #), Jobcode, and Account
· Columns: Year, Scenario, Version, and Period (months)
[bookmark: _Toc93939317]TBH Naming
As of Spring 2016, when adding a TBH planners can name their TBH employee.  The name however must be unique in order to distinguish it from other TBH members in the system.  When adding TBHs, planners are asked to follow the following format:
First use the DeptID naming convention in PeopleSoft to distinguish the control point; underscore; the department initials; underscore; the position or person.  For example:

D_OMFS_FIN MGR 1
N_PN_ANL IV
P_PC_ASST PROF 2

The examples above would translate to:
School of Dentistry, Department of Oral and Maxillofacial Surgery, Financial Manager 1
School of Nursing, Department of Physiological Nursing, Analyst IV
School of Pharmacy, Department of Pharmaceutical Chemistry, Assistant Professor 2.

Planners should coordinate with control point coordinators to add more or less unique identifiers to their TBHs.  Remember since TBH employees may be funded by multiple departments, you may share the same TBH employee to add distributions.  
[bookmark: _Toc93939318]Base Salary Calculation for TBH Employees
For To be hired employees, global assumptions do not apply.  If you plan to fill the TBH provision to include merit and other salary increases, simply enter the full salary rate level amount in the Base&Neg Salary.  
[bookmark: _Toc93939319]Negative Provisions
Planners will be able to create (or delete) provisions for planned new hire and negative provisions for salary savings due to separations or budget reductions.
For example, if you’re expecting $10,000 in salary savings, you can create a TBH with -10000 as base salary. Remember that the amount is pro-rated based on hire date.
[bookmark: _Toc93939320]Salary Distributions
Just as with existing employees, you will need to enter funding DFP distribution(s) whenever you fund all or part of that TBH employee’s salary.  This is true whether the TBH is in your salary level planning home DeptID or not.
For TBH employees that you own and fund, you will adjust distributions.
You will also adjust distributions on TBH employees you fund who are not in your salary level planning DeptID.   
Remember you will need to coordinate this with the salary planning level DeptID to obtain the correct TBH Employee name in order to add a pay distribution for this TBH provision.  Note that you will need to use the Search Individual TBH forms to access the distribution form.
[bookmark: _Toc93939321]Right-Click Menu Options
From the TBH Landing Page, the planners can select one of three options:
1. Add TBH
2. Delete TBH
3. Go to TBH Forms
   [image: ]Note:  Before any TBH rows exist, you will access the menu by right clicking in the blank row placeholder, to the left of the first column.  Once there are TBH rows, you will access the right-click menu by clicking in the right-most row heading, which holds Accounts. 
[image: ]
To add a TBH:
Right-click on the right-most row header and select Add TBH
 [image: ]

A prompt will appear. 
[image: ]

Use the Member Selection icons or enter data into the Value column to build the TBH you want.  
The following table describes the fields for which you will be prompted.  Certain fields will prepopulate based on where your cursor is when you selected the Add TBH. 
	Field
	Details

	Name
	Enter the unique name using naming convention above.

	Salary Level Planning DeptID
	Enter the Home DeptID, preceded by the letter “D”; must be a planning-level DeptID

	Year
	Enter the specific fiscal year for the Forecast or Year 1 (e.g. FY25 or 2024-25)

	Planning Scenario
	Enter “Forecast” or “Plan”

	Planning Version
	Enter Working (only option available)

	Jobcode
	Select a specific Jobcode; the code must be preceded by the letter “J”
Select NoTitleCode to plan for many employees with different job functions or if you don’t yet know what the jobcode will be
Note that “NoTitleCode” flows to General Planning “staff” staff and benefit accounts upon integration

	Hire Date
	Enter a date in the format M/D/YY or use the calendar look-up feature
The data entered will prepopulate the months for the salary rate level, benefit rate level, and DFP distributions. For example, if the planning scenario is Forecast and 3/1/24 entered as the hire date, March-June 
of the Forecast will pre-populate. 

	Total FTE (Full Time Equivalent)
	Enter 1 for a specific individual full-time requisition 
More than one headcount can equate to one full time equivalent employee (e.g. you can have 1 FTE but 2 headcount if TBH represents 2 part-time provisions) 
Type a decimal for one part time hire (such as .50 for one half time) 
Type a whole number greater than 1 to indicate group provisions; can be multiple full time or part time individuals, and it can be for similar jobcodes or generic jobcodes

	Total Headcount
	Enter the number of individuals this FTE entry represents 

	Grade or Step 
	Defaults NoGradeStep; selections can be made from the dropdown list

	Base&Neg Salary
	Enter a whole number (with no commas) 
Enter the annualized salary; the monthly amount is pro-rated based on hire date entered
If TBH is a group provision, the value should be combined total base and negotiated salary of the FTE and headcount (e.g. 5 FTE/headcount @ $50,000 = $250,000)

	Benefits Adj %
	Enter the percentage benefits rate to be applied to the base and negotiated salary
Simply enter the value without formatting.  Do not use the % sign or the decimal. For example, if you want to enter a 15% benefits rate, simply enter 15, not 15% or 0.15.


Once you have adjusted the various field values, hit Launch.
A message displays, indicating the TBH was successfully added.  Your new TBH will appear on the TBH Landing Page.
Click OK.
The TBH Employees Landing Page appears, with a row for the TBH provision you added. The TBH employee will appear within the DeptID you entered.  Remember, you will still need to add funding distributions for this TBH by navigating to the Search Individual TBH form via the Go to TBH Forms right-click menu and entering data in the Empl TBH Distr Pct tab.  
To delete a TBH:
Right-click on any account for the TBH you want to delete and select Delete TBH.
A prompt will warn you that you are about to delete a TBH. 
[image: ] 
To confirm you want to delete the TBH, click Launch.
A message appears, indicating that you successfully removed the TBH.
[image: ]
Select OK.
To adjust data for a TBH:
Right-click on any account value in the row for the TBH you want to adjust and select Go to TBH Forms.  This will take you to the Search Individual TBH form to make adjustments.

[bookmark: _Toc93939322]4.2 Search Individual TBH Form
The Search Individual TBH form is where you make adjustments to an individual TBH.  Similar to the Search Individual Employee form, this form is a composite with multiple tabs, but unlike the Search Individual Employee form, the Search Individual TBH form combines the tabs for salary level and benefit rate adjustments on a single tab.  Add or delete salary and benefit pay component accounts or pay distribution DFPs as needed using the right-click menus on the various tabs.
To adjust data for a TBH provision, use the same functionality as described in Section 2.0 related to the Individual Employee forms.  As with individual employees, you can perform the following:
· Adjust salary rate level and benefit rate by pay component on Tab 1 – Empl TBH Sal&Ben Level
 
[image: ]
· Adjust funding DFP distribution percentages and Add or delete a DFP distribution on Tab 2 – Empl TBH Dist Pct 

 [image: ]

· View calculated salary and benefit dollar distributions on Tab 3 – Empl TBH Distr Sal $ and Tab 4 – Empl TBH Distr Ben $   [image: ]

 [image: ]
· Adjust TBH characteristics on Tab 5 – Empl TBH Summary 
 [image: ]
[bookmark: _Toc93939323]5.0 Employee Planning Global Assumptions and Seeding 
This section provides an overview of global assumptions and seeding in the Employee Planning module.  In Employee Planning, the UPlan Administrator in Budget and Resource Management office (BRM) initially sets global assumptions for salary increases (these assumptions are based on information from Human Resources).  Planners with Level 1 or 2 Coordinator access can then adjust these global assumptions for their departments.  BRM does not establish any global assumptions for benefits though Level 1 or 2 Coordinators can make adjustments for their departments.  On the other hand, the UPlan system allows seeding to be done by any planner for their DeptID’s though you should check with your Control Point Coordinator to insure that they do not have internal processes in place where they handle the seeding.
[bookmark: _Toc93939324]Process
1. The application of global assumptions for salary increases is based on union codes, most of which are bargaining units.
2. Control points (Level 1) and Level 2 departments can adjust global assumption rates for salary increases.
3. Global assumptions for salary increases can only be applied to the base and negotiated salary for the Forecast, Year 1 plan, and Year 2 plan.  
4. Global assumptions are reflected against salary level upon save in the Salary Global Assumptions form.  
5. BRM usually sets the salary global assumption in February of every year.  If Control Points and Level 2 departments plan to change the BRM assumptions, it is advisable for them to set timelines for adjusting global assumption rates as it will impact the Base and Negotiated salary level for all employees in their departments.
6. Planners can override global assumptions for base and negotiated salary at the individual employee level.  
As noted above, only planners with Coordinator access have the ability to adjust the Global Assumptions form, and only at the Level 1 and Level 2 levels of the DeptID tree.  Planners can view the global assumptions on the Salary Global Assumptions form or on Tab 1 Empl Salary of the Search Individual Employee form.  To make adjustment for an individual, they can use the Override Global % account on Tab 1 Empl Salary. 
	Role
	Actions

	UPlan Administrator
	Sets initial global assumptions for Forecast, Year 1, and Year 2 which pushes down to Level 1 and Level 2 Coordinators.

	Level 1 Coordinator
	Adjust global assumptions.  Upon save, UPlan pushes the adjusted global assumptions to all DeptIDs within the control point. 

	Level 2 Coordinator 
	Adjust global assumptions.  Upon save, UPlan pushes the adjusted global assumptions to all DeptIDs within the department. 

	Planner  
	Adjusts Forecast and Year 1 Plan.  Global assumptions can be overridden by making adjustments for individual employees.


To review global assumptions for Employee Planning:
1. From My Task List, select Employee Planning > Empl Global Assumptions > Salary Global Assumptions.
2. Check the DeptID in the Page Filter.
3. To change the DeptID, click the drop down box in the Page Filter and type the id or number for your DeptID; then click the Go icon.  [image: ]
4. Review the effective month percentages entered by BRM or your coordinator(s) for Forecast, Year 1 Plan, and Year 2 Plan.  
[image: ]

[bookmark: _Toc378070087][bookmark: _Toc93939325]Salary Global Assumptions on TBH Provisions
As noted in Section 4.2 Search Individual TBH Form, salary global assumptions do not apply to TBH provisions. 
 
[bookmark: _Toc378070088][bookmark: _Toc93939326]5.1 Seeding in Employee Planning
Employee Planning includes a series of seeding rule options available to planners.  These rules are accessed via the Task List under Empl Seeding Options.  Separate seeding rules apply to salary levels, benefits rates, and pay distributions and are applied to the MyOrg DeptID chosen.  
 [image: ]
All Employee Planning seeding will include any global assumptions entered by Coordinators.  Global assumptions will automatically be applied to planned salary levels from Forecast when the planner runs the Year 1 – Salary Level and Year 2 – Salary, Benefits, and Dist Pct seeding rules.
Planners have the ability to override the benefits rate level and the distribution percentage in the open months of the forecast based on any other month in the Forecast via the seeding rules Forecast – Benefits Level and Forecast – Distribution Pct %.  Most of the forecast is pre-populated with the prior year Plan Final data and planners may wish to adjust their forecast across all the employees in their department. These two rules allow them to do so and save time.  Note that seeding the salary rate level in the forecast is not necessary or available since the levels are trued up with UCPath data at every month close and therefore, will always reflect the employee’s most current salary rate. 
Planners must seed their salary rate level, benefit rate level, and funding DFP distribution percentages.  These are based on information from the forecast.  After seeding Year 1 Plan, planners will be able to adjust salary levels, benefit levels, and DFP distributions for individual employees for Year 1 via the Search Individual Empl form or the Multi-Empl forms.  
Although planners cannot plan or view details for Year 2 plan, they have the ability to seed Year 2 based on information from the Year 1 plan.  The seeded information calculates behind the scenes and flow to Year 2 in General Planning.  The amounts can then be adjusted at the aggregated salary and benefits accounts in General Planning if needed.
[bookmark: _Toc93939327]Seeding Rules for Salary Levels
The Year 1 – Salary Level rule allows the planner to seed initial (July) base and negotiated salary levels for the Year 1 Working Plan from any month of any year/version/scenario.  Planner selects the Source Year, Version and Scenario, the Source Month, and the Target Year.  In most cases, Planner should select June of the current year as the Source Month to be applied to July of Year 1.
	Rule Name
	Plan – Salary Level 

	From Year/Version/Scenario 
	Any/Any/Any

	From Months
	Any

	To Year/Version/Scenario
	Year 1/Working/Plan

	To Months
	July


[bookmark: _Toc93939328]Seeding Rules for Benefit Rates
UPlan contains two rules for seeding benefits rates.  The first applies to the current year Forecast while the second applies to the Year 1 Plan.  
1. The first rule seeds the current year (Year 0) Working Forecast for the remaining non-actualized months of the current year.  Planner selects the source month choosing any month from the existing Year 0 Working Forecast (whether the month is actualized or not).  
	Rule Name
	Forecast – Benefits Level

	From Year/Version/Scenario 
	Year 0/ Working/Forecast

	From Months
	Any

	To Year/Version/Scenario
	Year 0/ Working/Forecast

	To Months
	All non-actualized


2. The second rule seeds the Year 1 Working Plan initial benefits rates for all months from any selected month of any year/version/scenario.  Planner selects the Source Year, Version and Scenario, the Source Month.  Note that global assumptions also apply.  Separate global assumptions should apply to July through November and December through June.  
	Rule Name
	Plan – Benefits Level 

	From Year/Version/Scenario 
	Any/Any/Any

	From Months
	Any

	To Year/Version/Scenario
	Year 1 /Working/Plan

	To Months
	All


[bookmark: _Toc93939329]Seeding Rules for Pay Distributions 
Two rules for seeding pay distributions allow planners to choose from several options.
1. The first rule seeds the current year (Year 0) Working Forecast for the remaining non-actualized months of current year.  Planner selects the source month, choosing any month from the existing Year 0 Working Forecast (whether the month is actualized or not).  
	Rule Name
	Forecast – Distribution Pct %

	From Year/Version/Scenario 
	Year 0/ Working/Forecast

	From Months
	Any

	To Year/Version/Scenario
	Year 0/ Working/Forecast

	To Months
	All non-actualized


2. The second rule seeds the Year 1 Working Plan for all months, based on a single month chosen by the planner.  Planner selects the Source Year, Version and Scenario, the Source Month.   
	Rule Name
	Plan – Distribution Pct %

	From Year/Version/Scenario 
	Any/Any/Any

	From Months
	Any

	To Year/Version/Scenario
	Year 1 / Working/Plan

	To Months
	All



Below are the steps for running these seeding rules:
Seeding the Forecast – Benefits Level
[image: ]
Click on Launch which will bring up a prompt for you to choose your DeptID that you want to seed for, the source month from the forecast, and the target months that you want to seed to.  Click on Launch to run the seeding rule.
[image: ]
Seeding the Forecast - Distribution Pct % [image: ]

Click on Launch which will bring up a prompt for you to choose your DeptID that you want to seed for, the source month from the forecast, and the target months that you want to seed to.  Click on Launch to run the seeding rule. [image: ]
Year 1 – Salary Level 
[image: ]
Click on Launch which will bring up a prompt for you to choose your DeptID that you want to seed for and the source month from the forecast.  Click on Launch to run the seeding rule. These will apply to all months in the Year 1 plan.  [image: ]
Year 1 - Benefits Level  
[image: ]
Click on Launch which will bring up a prompt for you to choose your DeptID that you want to seed for, the source month from the forecast, and the target months that you want to seed to.  Click on Launch to run the seeding rule. 
[image: ]
Year 1 - Distribution Pct % 
[image: ]
Click on Launch which will bring up a prompt for you to choose your DeptID that you want to seed for, the source month from the forecast, and the target months that you want to seed to.  Click on Launch to run the seeding rule. 
[image: ]
Year 2 - Salary, Benefits, and Dist Pct % [image: ]
Click on Launch which will bring up a prompt for you to choose your DeptID that you want to seed for and the source month from the forecast.  Click on Launch to run the seeding rule. These will apply to all months in the Year 2 plan behind the scenes and flow to Year 2 in General Planning.  
[image: ]
[bookmark: _Toc406504682][bookmark: _Toc93939330]6.0 Employee Planning Form Reports 
All Employee Planning Reports are Form Reports.  These are diagnostic reports that help you view employee salary plans and distribution information.  There are currently two reports available:
[bookmark: _Toc93939331]Compensation Detail by DFP
The Compensation Detail by DFP shows the details of employees funded by a specific DFP.  This form can be accessed under Employee Planning > Empl Reports or can be navigated to from the Revenue and Expense forms in General Planning via the right-click menu.
 [image: ]

[bookmark: _Toc93939332]Multi-Empl Distr Pct
The Multi-Empl Distr Pct and $ shows the funding DFP distribution percentages and calculated distribution dollars for salary and benefits under the selected MyOrg DeptID. 
 [image: ]

[bookmark: _Toc93939333]7.0 Other Employee Planning Topics
[bookmark: _Toc93939334]7.1 Handling Special Situations
[bookmark: _Toc93939335]Multiple Jobcodes
Employees with multiple jobcodes will appear on multiple rows on all forms.  Planners will need to create salary and benefit plans for each jobcode.
[bookmark: _Toc93939336]Medical Center Employees
Only employees with a campus home department (non-medical center) will appear in UPlan; employees with a medical center home department will not appear in UPlan.  In addition, distributions for employees with a campus home department but which are funded by the medical center will not appear in UPlan.
· You will use Employee Planning to plan for non-medical center employees of the campus, e.g., those with a campus home department.
· For employees with a medical center home department, but who are paid at least in part by a campus unit, planners will need to add the individual as a TBH employee.
· If an employee is owned by a campus home department, he/she will appear on the roster for that home department and the campus departments providing pay for that employee will enter their appropriate share.  The portion of their salary funded by the medical center will not be included in UPlan.  The home department need not worry about the medical center portion of the salary and benefits.
· Employees with a medical center home department will not appear in UPlan.  For employees with a medical center home department but are fully or partially paid by a campus department, the paying department will need to create a TBH provision and enter the appropriate salary and pay distribution percentage.  No special functionality is required.
[bookmark: _Toc93939337]Benefits for Fellows and Residents with No Salary (pending changes)
Postdoctoral fellows or other employees who have no salary, but do have benefits costs paid by UCSF will appear in the Employee Planning module.  Planners will need to manually adjust benefits levels and distributions.  Alternatively, planners can create a TBH provision with zero salary and manually benefits and distributions.  A second alternative is to make adjustments in the General Planning module.
The healthcare benefits for Fellows and Residents that are paid directly by the campus (i.e. HR) to a third party insurance company will be planned in the General Planning cube.  There are some benefits costs that go through payroll and reported as benefits costs, but these healthcare costs are reported under a non-benefits expense account which rolls up to Level E Account “5577E-Other services” which in turn rolls up to Level C Account “5550C-Services”.  Departments with these types of benefit costs should plan for them in the Revenue & Expense form in the General Planning module.
[bookmark: _Toc93939338]7.2 Adjusting Planned Salary and Benefits in General Planning
If your department or Control Point does not require detailed salary and benefit expense information, you can use the Revenue & Expense form in the General Planning Module to forecast or plan.
You may also want to perform the majority of your salary and expense planning within Employee Planning but still use the General Planning module for related adjustments. Keep in mind that when you use the Revenue & Expense form, you will work with DFP combinations.
[image: Table

Description automatically generated]
There are fourteen accounts related to salary and benefit expenses in the Level C-Revenue and Expense form.  Seven Level C accounts are from the Chart of Accounts and are read-only, numbered accounts that pull plan data from Employee Planning (note that actuals are fed from PeopleSoft GL). The other seven accounts are planning account only and are writable, non-numbered accounts where you can input salary or benefit adjustments against the Level C accounts plan amounts.



18	12/13/2024
12/13/2024	17
image2.png




image3.jpeg




image4.png
University of California
San Francisco




image5.jpeg
Plan Employee

Ronrpors
Use Disgnosic:
= Pln Toe Heot” ReviewBenofis | | Reports o mviow
Pan salary & benefits st - NIH Over i Do
0% | o cap





image6.gif




image7.png
> Forms

> Manage Task

My Task List
> B General Planning
# Employee planning
® 1ndiidual Empl Forms
& search Individual Empl
© Empl Landing Page

 wult-Empl Forms
P 124 Empl Forms
> B empl Global Assumptions
> B empl seeding options
> B empl Reports
& push Empl Data to General
> B adgministrator Tasks

> Dimension

> Business Rule Security

Task List Stal@

Task - Search Individual Empl

Task Instructions

Empl Sal&Ben Level  Empl

Employee Name & ID +

Pct | Empl Distr Sal

Empl Distr Ben §

DeptlD and
DeptiD Name

7001096: DEPARTMENT CHAIR.

J001734: HS CLIN PROF-HCOMP

Empl Summary
202425 202526 202627
Forecast Plan Plan
Working Working Working

> YearTotal > YearTotal > YearTotal

Initial Base&ieg Salary

Global Assumptions %

Override Global %

Global Assumptions Impact §

salary Level Override

New Base&Neg Salary

‘Addtl Salary 10,000

Ending Total Salary S w0

Benefits (%) 40.36%

Benefits Adj (%)

Benefits ()

Senefs Totls I .

Initial Base&Neg Salary
Global Assumptions %
Override Global %

391,762





image8.png
Empl Selfben Level | EmplDit Pt | Empl Disdr S35 | Empl i Ben 5| El Summary

P ™ Sen. oa MNov. Dec. Jen reb ar Ao Mey. Jun. 4 YearTotal » YearTotal » YearTotal
Prepe——
Gotramine
Erireesnerery
Sy Lot
e
privn 20 20 20 20 s
oo sy 3 [ a0 a0 s e
et 00 e
st 5
e 4
et Tt _______________
P e e e e e e e e
ey
ErireerereT
Sy ot O ssais ssais ssais ssais s
e e mess  mess  wmess  mess  mess  mess  mess  mes  mes  mes  mes  amam




image9.png
Empl Selfben Levl | Empl Distr Pet. | Empl it Sl § | Empl Dt Ben § | Empl Summary.
g g Wty
— i o s - v o Ve v |5 Yo
100109: EPARTHENT CHAR | MOt (09 | canazs. £ 7000 Wil War Endonsd e Y o N N En
ey a0 5315 2575 O gy e e e e e
1001754 HS LI FROTHCON? s 0t (%) 302025 10 2016505 500 st % ) % 3 3
ey 0 a5 2575 O gy o e o e e
pasie o ooumst s 201503: 500 Ginca rcty 100 oo
I00109: DEPHRTHENT CHATR At Dk (%) Tl Dt Dt Tl AL Funcs Tt A Prjcs 100 100 100 100 oo
1001734 H5 LI FROTHCOMP Basieg O (1) Tl Dt Dt Tl AL Funcs Tl A Prjcs 0 100 20 100 oo

PO

otad D> DogetID | Tota ARl Punc | Total A Pt




image10.png
Empl Sala8en Level | Empl Distr Pct | Empl Distr Sal § | Empl Distr Ben §

Empl Summary

1001096: DEPARTMENT CHAIR  Add Dist (%)

1001734: HS CLIN PROF-HCOMP  BaseNeg Dist (%)

Addt Dist (%)
1001096: DEPARTMENT CHAIR  Add Dist (%)
1001734: HS CLIN PROF-HCOMP  BasefiNeg Dist (%)

Addtl Dist (%)

D302025
D302049
D303036
D302025
D302049
D302051

7700
4200
5013
1900
4200
5013

202425
Forecast
Working

> YearTotal

B39315V: ZSFG Oral S
e i —

2016806: SOD Instruct
B39315V: ZSFG Oral St
2015038: SOD Clnical

Total Distrib DeptID Total All Funds Total Al Projects.
Total Distrib DeptID Total All Funds Total All Projects.
Total Distrib DeptID Total All Funds Total All Projects.

[E) Delete Dist
edt

Adjust

@ aachments
£ Lock/Unlock Cells
Fiter
Sort
3 analyze
&) New Ad Hoc Grid
(&) Show member in outline

202526
Plan
Working
> YearTotal

202627
Plan
Working
> YearTotal




image11.png
Runtime Prompts - AddDistrib
promse Tt
o s o
R,
& Solec e i DD
P e Fund
@ *sdearpros
& Solec e g Scsnr

e
“saseiieg D (54"

“awsizz

Member selection pull-down icon





image12.png
P&/ WAw@
Ales

TiteCode
AlTtle_Codes.

AV

[ Member Name.
4 TiteCode
3007708

™
TitieCode

“J007709: FINANCIAL ANL 3°





image13.png
Hember Selection

Dimensions A

Members | Varizbles

AarrBmYRe@

Member Name
4 Account

ISZ

Member Name
4 Account
“Addt Dist (%)"





image14.png
Runtime Prompts - AddDistrib. x

promse Tt abe
o s o s’ "
R, a3 "
& Solec e i DD

P e Fund s "
@ *sdaproe stz "

= solax e Paning Sesnr (i=== )e.





image15.png
@ Information

‘AddDistrb was successful.




image16.png
Empl SaldBen Level ~ Empl Distr Pt Empl Distr Sal $  Empl Distr Ben $

Empl Summary

J001096: DEPARTMENT CHAIR  Addtl Dist (%) D302025
D302049
D303036
J001734: HS CLIN PROF-HCOMP Base&Neg Dist (%) D302025

7700
4200
5013
1900

2024-25

Forecast

Working

> YearTotal

7700092 William Ware Endowed Chair 33%
B39315V: ZSFG Oral Surgery 1%
2016807: SOD Administrative 25%
2016806: SOD Instruction 8%

D302049 4200 B39315V: ZSFG Oral Suiei 92%

J001096: DEPARTMENT CHAIR  Addt! Dist (%) Total Distrib DeptD Total All Funds Total All Projects 100%
001734: HS CLIN PROF-HCOMP Base&Neg Dist (%) Total Distrib DeptID Total All Funds Total All Projects 100%
Addtl Dist (%) Total Distrib DeptID Total All Funds Total All Projects 100%

2025-26
Plan
Working
> YearTotal

2026-27
Plan
Working
> YearTotal




image17.png
@ Error

Planned Compensation doss ot exit or the Employee and
Tite selected.

[ox]





image18.png
Empl Sal&Ben Level  Empl Distr Pct | Empl Distr Sal §

Empl Distr Ben §

Empl Summary

1001096 DEPARTMENT CHAIR  Addt] Dist (%)

J001734: HS CLIN PROF-HCOMP  Base&Neg Dist (%)

Add Dist (%)

J001096: DEPARTMENT CHAIR  Addt] Dist (%)

7001734 HS CLIN PROF-HCOMP  Base&Neg Dist (%)
Add Dist (%)

D302025
D302049
D303036
D302025
D302049
D302051

Total Distrib DeptiD Total All Funds-
Total Distrib DeptiD Total All Funds-
Total Distrib DeptiD Total All Funds-

7700
4200
5013
1900
4200
5013

gs Eg Project
7R5892: william Ware Endowed Chair

B39315V: Z5FG Oral Surgery.
2016807: SOD Administrative
2016806: SOD Instruction
B39315V: Z5FG Oral Surgery.

[ Add_pist
Edit »
Adjust >
[ comments

%2 Supporting Detail
& change History

& attachments

£ Lock/unlock Cells

Filter »
Sort »

202425
Forecast
Working

> YearTotal

33%
a1%
25%

8%
92%

100%
100%
100%

202526
Plan
Working
> YearTotal

202627
Plan

Working

> YearTotal




image19.png
@ Information

Delete_Distribution was successful.




image20.png
Empl Sal&Ben Level Empl Distr Pt Empl Distr Sal $  Empl Distr Ben §  Empl Summary

202425
Forecast.
Working
P Nov Dec Jan Feb Mar Apr May Jun YearTotal
J001096: DEPARTMENT CHAIR  Addtl Sal Dist ($) 7700 333
4200 B39315V: Z5FG Oral Surgery 4133
5013 2016807: SOD Administrative s 2,533
J001734: HS CLIN PROF-HCOMP  Base&Neg Sal Dist ($) 1900 2016806: SOD Instruction 27 7,874
3040 1111111 General Unspecific 2,597
3080 2012222: Intl Dentistry Pathway 100
4200 'B39315V: ZSFG Oral Surgery 83 131,887
Addtl Sal Dist (5) 5013 2015038: SOD Clinical Faculty a7
J001096: DEPARTMENT CHAIR  Addtl Sal Dist (§)  Total Distrib DeptID Total All Funds Total All Projects 00 10,000
J001734: HS CLIN PROF-HCOMP Base&Neg Sal Dist ($) Total Distrib DeptID Total All Funds Total All Projects 15 142,459

Addtl Sal Dist (§)  Total Distrib DeptID Total All Funds Total All Projects an




image21.png
Empl Sal&Ben Level | Empl Distr Pct | Empl Distr Sal §

Empl Distr Ben §

Empl Summary

Project oct

3001096: DEPARTMENT CHAIR  Ben Dist ($) 7700 7700092 Wilam Ware End)\sed Chair 209
4200 B39315V: Z5FG Oral Surgery’ 440
5013 2016807: SOD Administrative 270
J001734: HS CLIN PROF-HCOMP. Ben Dist §) 1900 2016806: 50D Instructon 918
3040 1111111: General Unspecific
3080 2012222: Intl Dentistry Pathway
4200 B39315V: 25°6 Oral Surgery. 10987
J001096: DEPARTMENT CHAIR  Ben Dist ($) Total Distrib DeptID Total All Funds Total All Projects 1,009

1001734: HS CLIN PROF-HCOMP  Ben Dist (§) Total Distrib DeptID Total All Funds Total Al Projects 11,905

Nov

202425

Forecast

Working
Jan

Feb

Mar

May Jun 4 YearTotal
1,105

1,761

1,079

2,664

8652

23

44,002

4,036

47,601




image22.png
Empl Sal&Ben Level | Empl Distr Pct | Empl Distr Sal §

Empl DistrBen §  Empl Summary

~
bo02425 202526 202627
Forecast Plan Plan
Working Working Working
1001096 DEPARTMENT CHAIR Rank
Empl Grade_Step
FTE
Ending Total Salary
Ending Salary Variance § from Prior Year
J001734: HS CLIN PROF-HCOMP. Rank FuLL
Empl Grade_Step Grade 1
FTE 1.00
Beginning Total Salary 427,377
Ending Total Salary 427,377
Ending Salary Variance § from Prior Year 427,377 427,377
‘Ending Salary Variance % from Prior Year -100%




image23.png
Enterprise Performance Management System Workspace, Fusion Edition

> Forms User Preferences

> My Task List
Appication Settings || Display Options | Printing Optons:

ferences
preferences Dimension User Varizble Namv

DeptD Myorg
Employee MyHD_Employees #.

a et




image24.png
Task - Empl Landing Page  Task Instructions.

DeptiD

001454 ASSOC PROF OF CLIN-HCOMP

J003310:
3008335:
J003252:
3008335:

3001728: ASST ADI PROF-HCOMP
3009611: SRA 3

3004263: ADMIN OFCR 2 CX
3009549: CLIN RSCH ANL 4
3003252: POSTDOCEMPLOYEE
3003253: POSTDOCFELLOW

: ASST AD] PROF-HCOMP.

Oatorg:
200425
Forecast

New Basetieg Salary
578
147
s7784
6613
59,200
7083
B2
7054
71,660
60,080
79357
162224
06755
76123

15,855
57,300
136,425

202425
Forecast

1.00

1.00

1.00
1.00

100
100
100
100
100

077
1.00

202425
Forecast

BasefilNeg Dist (%)

202425

June Variance
[FTE-Base&iNeg

Distd%]

100%

100%

100%
100%

100%
100%
100%
100%
100%

7%
100%

202526
Plan

New Base&Neg Salary

202526
Plan




image25.png
3008526
J006250:
J004723:
30085231
008534
008526
0084861
30085231
3008525
3008525
3008525
3008525

300953¢

ANMLTG
A

EQ v
BLANK AS

Adjust »
ANMLTCH

(B comments

ANML HE?

‘Supporting Detail

ALTCH

Change Histor
wroga e

Attachments
AwLTCH

£ Lodkjunlock Cells

ALTCH

Fter ,
ALTCH

Sort ,
AMMLTCE g ectal
ALTCH

Apply »
ANML HEALTH TCHN 2




image26.png
Employee Landing > Employee Composite

4

3]
Empl Sal&Ben Level | Empl Distr Pet | Empl Distr Sal § | Empl Distr Ben $ || Empl Summary
202425 20526 202627
Forecast Plan Plan
Working Working Working
DeptiD > YearTotal > YearTotal > Yearfotal
1004730 BLANK AST 2 PD_ Inital Base&Neg Salary 5,908
Global Assumptions %
Override Global %
-» Global Assumptions Impact
salary Level Override 1239
New Base&Neg Salary 11,147
Addt salary
Ending Total Salary S ww
Benefits (%)
Benefits Adj (%)
Benefits ($)
Benefit & Totals e




image27.png
[Employee Landing |- Employee Composite

4

3]
Empl Sal&Ben Level | Empl Distr Pet | Empl Distr Sal § | Empl Distr Ben $ || Empl Summary
202425 20526 202627
Forecast Plan Plan
Working Working Working
DeptiD > YearTotal > YearTotal > Yearfotal
1004730 BLANK AST 2 PD_ Inital Base&Neg Salary 5,908
Global Assumptions %
Override Global %
-» Global Assumptions Impact
salary Level Override 1239
New Base&Neg Salary 11,147
Addt salary
Ending Total Salary S ww
Benefits (%)
Benefits Adj (%)
Benefits ($)
Benefit & Totals e




image28.png
 Manage Task Lists
My Task List
> P General Planning
® empioes planning
B Ingividual Empl Forms

& search Indiidual Emi

> B Mutt-Empl Forms
> B 781 Empl Forms
> B Empl Global Assumptions
> B Empl seeding Options
> P Empl Reports
© push Empl Data to General
> B pdminisrator Tasks
I

Task - Empl Landing Page  Task Instructions.

[Employee Landing |- Employee Composite

|3

Empl SalkBen Level | Empl DistrPct | Empl Distr Sal § | Empl Distr Ben§ | Empl Summary

202425 202526 202627
Forecast Plan Plan
‘Working Working ‘Working
> YearTotal © YearTotal © YearTotal
1004730: BLANK AST 2 PD  Initial Base&Neg Salary. 9,008
Global Assumptions %
Override Global %
Global Assumptions Impact §
Salary Level Override 1,239
New Base&Neg Salary 11,147
Addtl Salary
Ending Total Salary R A
Benefits (%)
Benefits Adj (%)
Benefits ($)

Renefit ¢ Takale




image29.png
‘Task - Multi-Empl Sal&Ben Level

Task Instructions

001454 ASSOC PROF OF CLIN-HCOMP

J004730: BLANK AST 2 PD

9aMyorg:

Initial Base&ieg Salary.
Salary Level Override
New Base&iNeg Salary
Benefis (%)

Benefits Adj (%)
Benefits ($)

Initial Base&ieg Salary.
Salary Level Override
New Base&iNeg Salary
Benefis (%)

Benefits Adj (%)
Benefits ($)

202425
Forecast
Working

> YearTotal

252,800

91,928
275,782
77.85%

190772
9,008
1,239

11,147

202526
Plan
Working
> YearTotal

202627
Plan
Working
> YearTotal




image30.png
Task - Multi-Empl Distr Pct | Task Instructions

% DeptiD

1001454: ASSOC PROF OF CLIN-HCOMP Base&Neg Dist (%)
1007890: CLIN SOCIAL WORKER 1 EX Base&Neg Dist (%)
1001454: ASSOC PROF OF CLIN-HCOMP Base&Neg Dist (%)

Addtl Dist (%)

OuMyorg:

7000
4301

4300

1900
4000

7000
7000

7030468
1405374
13703180
1387458
peeeeeey
1435628
1441528
1416888
1416888

7029089

Accurso,E_Eating Disorders
‘GRANT NUMBER:2022-2461/Accurso
Implementing Family-Based Trea

TP EMBRACE

General Unspecific

ROIMH135376 / Acharya
1RO1TWO12682-01A1 ACHARYA
‘Supplement - 3R01MH133231-0251
ROIMH133231/Acharya

: Acharya,B_Psy_Glbl_Mental_Hith
7029089

Acharva.B Psy Glbl Mental Hith

202425
Forecast
Working

> YearTotal

0%
70%
5%
200%
0%
a25%
16.09%
8.04%
36.2%
203%
100%

202526
Plan
Working
> YearTotal

202627
Plan
Working
> YearTotal




image31.png
o0 [ssiis Grenlurpeche -

‘Working
> YearTotal

2012634 SON Info Sys & Data ot Add_Dist

1111111: General Unspecfic 2y Delete ist
1111111: General Unspecfic G0 to Empi Forms.
2002153 SON DO_Dearis Suppl Comp Fun [ 6o to ¥ Forms
1111111; General Unspesfic Edt ,
2002153 SONDO_Dean's Suppl CompFun __ Adiust ’
7002371 SON Arnual Fund

1111111: General Unspecfic 2 supportig Detal
1111111: General Unspecific & Change History.
1111111: General Unspecific @ Attachments
1111111: General Unspecific {8 Lock/uriock Cells
1111111: General Unspecfic Fiter ’
1111111: General Unspecfic sort ’
1111111: General Unspecfic seectal

2013114: SON DO Assoc Dean Academic A

‘Working
> YearTotal

100%

100%
100%

0%
100%

e
100%
100%
100%




image32.png
My Task List
> P General Planning
® empioes planning
> B Indiidual Empl Forms
B wuit-Empl Forms

© Mult-Empl Sal&Ben Level
© Mult-Emp Distr Pet

P T8 Empl Forms
& Search Individual TEH,

¥ Empl Global Assumptions
> B Empl seeding Options
> B empl Reports
© push Empl Data to General
> B pgminisrator Tasks

N_DO_Harris,Mattice

N_SON_Dir of Simulations
N_DO_Admin Budget/Finance Analyst

N_SON_RSA4

N_DO_Finance Mgr

N_SON_RSA3

1000532

000843
1007709

1006207

1000213

1006206

@4 Myorg:

TitleCode
: IT ARCHITECT 5

: ACADEMIC COORD II-FY
: FINANCIAL ANL 3

: RSCH ADM 4

: FINANCIAL ANL MGR 2

: RSCH ADM 3

New Base&ieg Salary.
New Base&ieg Salary.
New Base&ieg Salary.
Benefits Adj (%)
New Base&ieg Salary.
Benefits Adj (%)
New Base&ieg Salary.
Benefits Adj (%)
New Base&ieg Salary.
Benefits Adj (%)

202425
Forecast
Working

> YearTotal

220,964
130,667
117,420
42%
130,250
42%
226,806
35.2%
105,400
2%

202526
Plan
Working
> YearTotal

27,592
134,587
120,093
a%
134,160
a%
233610
3s52%
108,562
4%

2026-27
Plan
‘Working
> YearTotal




image33.png
Task - TBH Landing Page | Task Instructions.

94My0rg:
202425 202526 202627
Forecast Plan Plan
‘Working Working ‘Working
DeptlD > YearTotal > YearTotal
N_DO_Harris Mattice 3000532: IT ARCHITECT 5 ) 27,502
N_SON_Dir of Simulations 1000843: ACADEMIC COORD II-FY 134,587
- N_DO_Admin Budget/Finance Analyst  007709: FINANCIAL ANL 3 D
2%
O J006207: RSCH ADH 4 NewBases  Edit » 134,160
Benefits Ac  Adjust » 2%
N_DO_Finance Mar 1000213: FINANCIAL ANL MGR 2 New Bases [B) Comments a0
Benefits Ac %2 Supporting Detai 35.2%
ETUL=D IIEEEATD New Bases (5] change History 106,562
Benefits Ac ) Attachments 2%
N_SON_Contracts-Grants Mar 7000381; CONTRACTS AND GRANTS MGR 1 vy, Bases ) Lock/Unlock Cell e
Benefits Ac  Filter » 35.2%




image34.png
> Forms Task List Status

Lo AL TS Task - TBH Landing Page | Task Instructons

> B General Planning
4 P engloyee paming
> B Indvidual Empl Forms

> B s mpl Forms o dae o disley
4 P raEnplForms. peeteTaR
¥ Search Indvidual TBH (460 to TEH Forms
© T8 Landing Page Fiter »
> P Empl Gobal Assumptons Apply >
> B empi seeding Optons
> B EmplReports.
 push Emp Data to General

There are no vald rows of data for this form.




image35.png




image36.png
Runtime Prompts - Add Dynamic TBH
Prompt Text

= TBH Name

= tiselecta Job Code:

& = 1:Select DeptlD

i = Liselect Year.

= LiSelect the Plaming Scenario
= LiSelect the Plaming Version
i = 1:Enterthe e Date

(i) = 1:Enterthe Tota FTE

(] = 1:Enterthe Total Headcount
18] * L:Select the Grade/Step

(1) = 1:Enter Baseieg Salary

(i) 1:Enter Bencfi Ad) (%)

Value
v,
v,
v,
v,

Workng ’.
@

i

:

(NoGrdestep





image37.png
Launch Confirmation Message

‘Warning: This TBH and al it Distrbutins wil be permanently deleted

ik OK to continue.

o] [ cancel

i




image38.png
@ Information

DeIDyrTBH_Run€mpComp was successful.




image39.png
Empl TBH Sal&Ben Level | Empl TBH Distr Pct| Empl TBH Distr Sal §  Empl TBH Distr Ben $ | Empl TBH Summary

202425 202526 202627
Forecast Plan Plan
‘Working Working ‘Working
© YearTotal © YearTotal © YearTotal
DT LTEETS ) BaseNeg Salary 220,221 227,040
BaseilNeg Salary
New BasetiNeg Salary 220,964 227,592
Plan Addt! Sal
Ending Total Salary 220,964 227,592
Benefits Adj (%)
Plan Total Benefits. 81,160 83,595

Benefit & Totals 81160 83595




image40.png
Empl TBH SalgBen Level  Empl TBH Distr Pct | Empl TBH Distr Sal § | Empl TBH Distr Ben $ || Empl TBH Summary.

202425 20526 202627
Forecast Plan Plan
Working Working Working
> YearTotal > YearTotal > YearTotal
J000532: T ARCHITECT 5. Basesieg Dist (%) | 1500 [TIITIIT GoneralUmB= [\ ==~ | msw|
|21 Add_pist
2] Delete Dist
Edit »
Adjust >
[ comments
% supporting Detail
& change History
@ attachments.
£ Lock/unlock Cells
Fiter »
sot »
D analyze




image41.png
Empl TBH Sal&Ben Level  Empl TBH Distr Pt Empl TBH Distr Sal $  Empl TBH Distr Ben §  Empl TBH Summary

% 2024-25 202526 2026-27
Forecast Plan Plan
Working Working Working
Project > YearTotal > YearTotal > YearTotal

J000532: IT ARCHITECT 5 Base&nNeg Sal Dist ($) 1900 111111:

‘General Unspecific 18,414 28,449




image42.png
Empl TBH Sal&Ben Level

Empl TBH Distr Pct
N

Empl TBH Distr Sal §  Empl TBH Distr Ben $  Empl TBH Summary

[

Account

000532: IT ARCHITECT 5 Ben Dist ($)

202425 202526 202627
Forecast Plan Plan
Working Working Working
> YearTotal > YearTotal > YearTotal
1900 1111111: 6,763 10,449





image43.png
Empl TBH SalBen Level | Empl TBH Distr Pct | Empl TBH Distr Sal § | Empl TBH Distr Ben ¢ Empl TBH Summary.

% 202425 202526 202627
Forecast Plan Plan
TitleCode Working Working Working
J000532: IT ARCHITECT 5 o

Empl Grade_Step
FTE
Headcount

Empl Hire Date




image44.JPG




image45.png
My Task List
> B General lanning
4 B Employee panning
> P tndiidual Empl Forms
> B miteml Forms
P 724 Empl Forms.
4 Empl Global Assumptions
@ Salary Global Assumptions
P Empl secding Options
> P empl Reports
 push Empl Data to General
> B sdminstator Tasks

555555: Chancellr UCSF Input [+ 3]

95 No Bargaining Unit Assumptons
5 NonRep Clrical & Aled Srvcs Assumtions
9F: Nonep Paien Care Technicl Assumptions
93: Nonfep Health Care Professions Assumptions
9K Nonkep Sklled Craft Assumbons

SN: NonRep Registered Nurses Assumptions

9U: NonRep Service Assumptions

A2 Academic Senate Assumptions

865 UCSD Campus Marine Crew Assumptions.

B Gracuate Student Researchers Assumptions
B Readers & Tutors Assumtions

(CR: LOM CNA/ Regstered Nurses Assumptions
X Cleical & Aled Services Assumptions

X: Physicians, Dentists and Podiatrss Uni Input
X Pabent Care Technical Assumbons

FC: VR NUBW - Clerical A r Assumbons
FH: FVR NUHI Heslth Cae Professo Assumptions
FN: FVR NUHW Siiled Craft Assumptions

FP: FUR NUHW - Patent Care Techni Assumbons
FRs FVR NUW Registered Nurses Assumtions
FS: FUR NUW Servie Assumptions.

FX: Non-Senate Academic Research Prfessionas Assumptions
rining Trades Assumptons

L LOM SETU Health Care Prafeccio Aceumotione.

Forscast Plan
202625 w2526
SsllncrMonth  BaseSsl%  SallncrMonth  Basessl%
2l 300%
2l 300%
ozt 1670%
2l 300%





image46.png
My Task List
> B General Planning
4 P enpioyee Planring
> B Indvidual Empl Forms
> B it £mpl Forms.
> B 1ot empi Forms
> Empl Gobal Assumptons
"+ i Seeding Opiors
Forecast - Benefis Level
© Forecast -Distrbuton Pct %
 Year 1-Salary Level
& Year 1-Benefis Level
© Year 1-Distrbution Pct %
 Year 2 -Salary, Benefits, and DitPct %
> B Empl Reports
& push Empl Data to General





image47.png
> Forms
My Task Li

> B General Planning
4 P empioyee Pamning
> B Indvidual Empl Forms
> B it £mpl Forms.
> B 1ot empi Forms
> B empl Gobal Assumptons
4

¥ [Forecast - Benefits Level]
Forecast-Distrbution Pt %
 Year 1-Salary Level
& Year 1-Benefis Level
© Year 1-Distrbution Pct %
 Year 2 -Salary, Beneft, and DitPct %
> P EmpiReports
& push Empl Data to General

Task List Status
Task - Forecast - Benefits Level | Task Insiructons
Launch Business Rules

PlanType Empl
Business Rule. SeedFcstBen_RunEmaComp.




image48.png
Runtime Prompts - SeedFcstBen_RunEmpComp
o Tex

S DesD

i * 5t Vorth oy fom

57 % 1Pesse st Dt Heri.

ake




image49.png
> Forms
My Task List

> B General Planning
4 P empioyee Pamning
> B Indvidual Empl Forms
> B it £mpl Forms.
> B 1ot empi Forms
> B empl Gobal Assumptons
4 P engl eedng Options:
© Forecast -BenefitsLevel
Forecast
Year 1

Sy Leval
& Year 1-Benefis Level
© Year 1-Distrbution Pct %
 Year 2 -Salary, Beneft, and DitPct %
> P EmpiReports
& push Empl Data to General

Task List Status

Task - Forecast - Distribution Pct % _Task Insiructions

Launch Business Rules
PlanType Empl
Business Rule SeedFestDist_RunEmaComp.
[Launch |




image50.png
Runtime Prompts - SeedFcstDist_RunEmpComp x

Prompt Tex: ake
pE—r— o,
4 * tisdec Moeh o copy fom o,
57 * 11Pcsce ssec Dasenton Morth), s

Launch | Cancel || Create runtime prompt vakes fle |




image51.png
> Forms
My Task List

> B General Planning
4 P engloyee paming
> B Indvidual Empl Forms
> B it £mpl Forms.
> B 1ot empi Forms
> B empl Gobal Assumptons
4 P engl eedng Options:
 Forecast -BenefitsLevel
&
¥ Year 1= Salary Level]
Year 1-Benefis Level
© Year 1-Distrbution Pct %
 Year 2 -Salary, Beneft, and DitPct %
> P EmpiReports
& push Empl Data to General

Task List Status
Task - Year 1- Salary Level | Task Instructons.
.
PlanType Empl

Business Rule. SeecPlanSalYr1_RunEmaComp.
[Launch |




image52.png
Runtime Prompts - SeedPlanSalVr1_RunEmpComp. =
Prompt Tex: ake
pE—r— :
™ s Month 0 copy From o,

Lounch || Ganeel | Greste runtime prome vakes e |




image53.png
> Forms
My Task List

> B General Planning
4 P engloyee paming
> B Indvidual Empl Forms
> B it £mpl Forms.
> B 1ot empi Forms
> B empl Gobal Assumptons
4 P engl eedng Options:
 Forecast -BenefitsLevel
© Forecast -Distrbuton Pct %

 Year 1-Salary Level

F vear 1-Davbutonpet %
 Year 2 -Salary, Beneft, and DitPct %
> P EmpiReports
& push Empl Data to General

Task List Status
Task - Year 1 - Benefits Level | Task Instructons
Launch Business Rules
PlanType Empl

Business Rule. SeedPlanBen’r1_RunEmaComp.
[Launch |




image54.png
Runtime Prompts - SeedPlanBenY r:

Prompt Tex: ake
pE—r— o,
4 * tisdec Moeh o copy fom o,
57 * 11Pcsce ssec Dasenton Morth), s

Launch | Cancel || Create runtime prompt vakes fle |




image55.png
> Forms
My Task List

> B General Planning
4 P engloyee paming
> B Indvidual Empl Forms
> B it £mpl Forms.
> B 1ot empi Forms
> B empl Gobal Assumptons
4 P engl eedng Options:
 Forecast -BenefitsLevel
© Forecast -Distrbuton Pct %
 Year 1-Salary Level
& Year 1 Benefis Level
ear 2-Salary, Genehis, and Dt Pet %
> P EmpiReports
& push Empl Data to General

Task List Status
Task - Year 1 - Distribution Pct % | Task Instructions
Launch Business Rules

PlanType Empl
Business Rule. SeedPlanDistr 1_RunEmaComp.




image56.png
Runtime Prompts - SeedPlanDistr?

Prompt Tex: ake
pE—r— o,
4 * tisdec Moeh o copy fom o,
57 * 11Pcsce ssec Dasenton Morth), s

Launch | Cancel || Create runtime promet vakes fe |




image57.png
> Forms Task List Status

Lo AL TS Task - Year 2 - Salary, Benefits, and Dist Pct % _Task Insiructions

> B General Planning
4 B engloyee plarning
> B Indvidual Empl Forms PlanType Empl

. Multi-Empl Forms fue ear2F

Launch
> B 1ot empi Forms S

> B empl Gobal Assumptons
4 P engl eedng Options:
 Forecast -BenefitsLevel

Launch Business Rules

© Forecast -Distrbuton Pct %
 Year 1-Salary Level
& Year 1-Benefis Level
 Year 1 Distrbution et %
¥ [¥ear 2 Salary, Beneits, and Dist Pet %]
> PEmirears
& push Empl Data to General





image58.png
Runtime Prompts - SeedPlanYear2_RunEmpComp. S
Prompt Tex: ake
pE—r— :
™ s Month 0 copy From o,

Lounch || Ganeel | Greste runtime prome vakes e |




image59.png
Task - Compensation Detail by DFP

Task Instructions.

Total Al Employes

Staft_Banefts

Total Al Employes

EE

w2527
Plan
Working
 YearTotsl

s000 v] 1111111: General Unspeciic
202425 0526
Forecast Plan
Working Wering
> Yeartotal > YearToal
3007710: FINANCIAL ANL 4 602
2006206; RSCH ADM 3 8091
2006206; RSCH ADM 3 8051
3007710: FINANCIAL ANL 4 362
Total Al TiteCode: o wm
3007710: FINANCIAL ANL 4 28
2006206; RSCH ADM 3 3197
2006206; RSCH ADM 3 3197

2007710: FINANCIAL ANL &

218
Total All TieCode EEE




image60.png
” Manage Task Lists Task - Multi-Empl Distr Pctand $  Task Instructions.

My Task List
9 Myorg
> B General planning C
4 Employee Planning =4 = e
re ian ian
B Ingividuzl Empl Forms e e e
 wuit-Empl Forms YearTotal YearTotal YearTotal
:mu Empl Forms J001710: ASSOCPROF-HCOMP  paseaneq Dist (%)  D316002 7710 : Styles Deans Prof in Nursing 10%
? Empl Global Assumptions BaseRiNeg Sal Dt (§) D316002 7710 : Styles Deans Prof in Nursing 4115
» Empl Seeding Options Ben Dist () D316002 7710 : Styles Deans Prof in Nursing 1385
Eml Reports J000540: ADMIN MGR 3 BasegiNeg Dist (%)  D316002 1900 : General Unspecific 100% 100%
© Compensation Detail by DFP
b4 BaseRiNeg Sal Dt (§) D316002 1900 : General Unspecific 308,472 37,715
Multi-Empl Distr Pct and © gt
& pushem Ben Dist D316002 1900 1111111: General Unspeciic 2717 111,836
pl Data to General
3004574: STOT SVCADVISOR 2 BaseSiNeg Dist (%) D316002 B
» B Administrtor Tasks 1900 1111111: General Unspeciic 20%
3050 1111111: General Unspecific 79.99%




image61.png
Actual Actual Plan Forecast Plan Plan
Fral Fral Fnal Working Working Working
> YearTotal > YearTotal > YearTotal > YearTotal > YearTotal > YearTotal
Completion Tradkng
4000C: General state appropriations_C 4,080,326 1,491,333 1,991,333
T state appropriaton C 3,579,200 2,087,867 4,193,600 4,303,200
Total Revenue. 4,080,326 191,333 3,579,200 3,579,200 4,193,600 4,303,200
5000C: Faculty saaries_C 2,093,384 737,751 1,688,893 1,732,805
Facuty saary adustment 238,520 238,520 343,200
S010C: Faculty bonuses & incentives_C 513 4815 4815
5030C: Faculty benefits C 746,751 171,858 481,384, 40,297
Facuty benefits adjustment 81,283 451,129 118,904
5020C: Non-faculty academic saaries_C 8,610 4,445 3,75 4,867
5040C: Non-faculty academic benefits_C 3,068 23 58 a3
5050C: Staff saaries and overtine_C 621,793 215,718 410,774 539,802
Staff salary adustment 27,65 156,129 01,440
5060C: Staff benefits_C 235,724 8,914 173,914 24,741
Staff benefits adjustment 78,137, 87,500 138,57
Total Comp. 3,984 125,714 3,624,865 359,418 1,001,541
5510C: Assessments expense_C 58,092 133,954 136,232
5515C: Supples and materils_C 5,530 2,889 20,000 14,881 2,000
5550C: Services_C 224,091 3,454 7,58 209,799 210,689
Total Non Comp 232621 97,434 24,552 %0,912 230,689
Total Expense. 3,992,465 1321,1% 3,899,417 4,201,331 1,232,2%
Income/{Loss) from Operations 137,860 170,185 270217 722,131 2,961,370 4,303,200
32,605 52031 2,031
26,700 15,575 26,700 26,700
32,605 52031 26,700 67,606 26,700 26,700
Change i Net Position 170,465 222,216 243,517 654,525 2,988,070 4,329,900
“Total Net Positon - Beginning of Period %5 70,%5 %5 64,060 2,504,011
Total Net Position - End of Period 170,465 392,681 73,052 484,060 2,504,011 6,833,911





image62.jpeg




